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[Abstract] This protocol demonstrates a simple method to determine the subcellular localization of 

fluorescence-tagged proteins on the vibratome sections of rice developing anthers. If a cell type-specific 

promoter is used to drive the tagged protein-encoding gene, the method enables to clearly distinguish 

the cells retaining fluorescent signals from other anther cells. It is applicable to both live and fixed 

samples, and presumably to other plant tissues. 
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Materials and Reagents 
 

1. Micropipette tips 

2. Razor blade (FEATHER Safety Razor, catalog number: 99027) 

3. 2 ml Safe-Lock microtube (Eppendorf, catalog number: 0030120094) 

4. Microscope slide glass (Matsunami Glass, catalog number: SMAS-01) 

5. Coverslip (Matsunami Glass, catalog number: C218181) 

6. CRYO DISH No2 (SHOEI WORK’S, catalog number: 1101-2) 

7. (Optional) 15 ml centrifuge tubes (TPP Techno Plastic Products, catalog number: 91015) 

8. (Optional) Nylon filter mesh sheet 

9. Young panicles at a preferred developmental stage from transgenic rice plants expressing 

fluorescent proteins (if you target meiotic stages in japonica rice varieties, use 4-8 cm long 

panicles containing flowers with 0.5-0.9 mm long anthers) 

10. Low melting temperature agarose (SeaPlaqueTM Agarose) (Lonza, catalog number: 50101) 

11. ddH2O 

12. Krazy Glue® (Krazy Glue, catalog number: KG585) 

13. VECTASHIELD mounting medium with DAPI (Vector Laboratories, catalog number: H-1200, 

store at 4 °C in the dark condition) 

14. Nail polish 

15. (Optional) Paraformaldehyde (Wako Pure Chemical Industries, catalog number: 162-16065) 

16. (Optional) 5 N NaOH solution 

17. (Optional) Ice 

18. (Optional) PIPES (Wako Pure Chemical Industries, catalog number: 345-02225) 
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19. (Optional) EGTA (Wako Pure Chemical Industries, catalog number: 342-01314) 

20. (Optional) MgSO4·7H2O (Wako Pure Chemical Industries, catalog number: 138-00415) 

21. (Optional) KOH solid (60 g or more, Wako Pure Chemical Industries, catalog number: 168-

21815) 

22. (Optional) Glycerol (Wako Pure Chemical Industries, catalog number: 075-00616) 

23. (Optional) DMSO (Wako Pure Chemical Industries, catalog number: 048-21985) 

24. (Optional) 5x PMEG stock buffer (see Recipes, store at 4 °C. It is available for 6 months) 

 

Equipment 
 

1. Micropipettes 

2. (Optional) Measuring cylinder 

3. 100 ml polypropylene beaker 

4. (Optional) 200 ml or 300 ml flask 

5. Standard microwave oven 

6. Block incubator (ASTEC, model: BI-525A) 

7. Stereo microscope (Nikon, model: SMZ445) 

8. Fine forceps (Fine Science Tools, DUMONT, model: #5) 

9. Vibrating microtome (MicroSlicer) (DOSAKA EM, model: ZERO-1) 

10. Confocal Laser Scanning Microscope (CLSM, Olympus, model: FV300) or fluorescent 

microscope 

11. (Optional) Autoclave 

12. (Optional) Vacuum Pressure pump (e.g., Merck, model: WP6122050) 

13. (Optional) Vacuum desiccator (e.g., SP Scienceware - Bel-Art Products - H-B Instrument, 

catalog number: F42400-2041) 

14. (Optional) Sample Shaker 

15. (Optional) Water bath 

 

Software 
 

1. ImageJ (or Fiji) 

2. Photoshop CC (Adobe) 

 

Procedure 
 
A. Fixation of young rice panicle (Optional) 

1. Preparation of fixative and wash buffer (for 10 samples) 

a. In a 200 ml or a 300 ml flask, dissolve 4 g of paraformaldehyde (PFA) in 80 ml of ddH2O 

with 25 μl of 5 N NaOH. 
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b. Incubate at 65 °C until the solution becomes clear. 

c. After cooling down the solution at room temperature, add 20 ml 5x PMEG stock buffer (see 

Recipes) and mix it well (4% PFA/1x PMEG fixative). 

d. Prepare 500 ml of 1x PMEG wash buffer by diluting 100 ml of 5x PMEG stock buffer with 

400 ml of ddH2O. 

2. Sample collection and fixation 

a. Cut a tiller at the basal of the rice plantlet just before the heading stage, and immediately 

put into water to keep it fresh. For panicles at meiotic stages, choose the tiller with ± 5 cm 

distances between auricles of the last two leaves (in case of japonica varieties). Extract the 

young panicle from the tiller stem, and immerse it into ~10 ml of 4% PFA/PMEG fixative in 

a 15 ml screw-cap tube. 

b. Put the tube containing the panicles on ice into a vacuum desiccator. Apply vacuum for 20 

min and then release the vacuum gently. Repeat this operation 4 times without solution 

exchange. Covering the solution surface with a sheet of nylon mesh filter (30 x 30 mm) may 

be helpful to keep the samples immersed during vacuuming.  

c. Close the cap, lay the tube on a shaker and gently shake the sample at room temperature 

for 100 min. 

d. Discard the fixative, and wash samples with 10 ml of 1x PMEG buffer for 20 min with gentle 

shaking. Repeat washing 6 times each with new 1x PMEG. 

e. Store the samples in 10 ml of new 1x PMEG buffer in the dark at 4 °C. 

 

B. Agarose embedding and sectioning of rice anthers 

1. Preparation of agarose 

a. In a 100 ml polypropylene beaker, dissolve 1.5 g of low melting temperature agarose in 27.5 

ml (25 ml + 10% excess) of ddH2O using a microwave oven. Carefully remove bubbles by 

repeated heating and cooling. 

b. Separate melting agarose equally to 2 ml each in safe-lock tubes (Figure 1A). Incubate 

tubes with melting agarose at 50 °C in a block incubator until use (Figure 1B). 

 

 
Figure 1. Preparation of agarose. A. Dividing melted agarose into 2 ml microtube. B. 

Microtubes with melted agarose on a block incubator. 
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2. Agarose embedding 

a. Dissect rice flowers from live or fixed panicles (Figure 2A) (see Procedure A for PFA fixation). 

Remove lemma and palea from flowers under a stereo microscope. DO NOT detach anthers 

from a floral basal for easy handling in following steps (Figure 2B). 

 

 
Figure 2. Sample dissection. A. A dissected rice young panicle (an arrow) and flowers at 

meiotic stages (arrowheads). Scale bar = 10 mm. B. A stereo microscopic view of internal floral 

organs, including anthers and a pistil, after removing lemma and palea. Scale bar = 1 mm. 

 

b. Put flowers in the center of CRYO DISH and pour the melting agarose (Figure 3A). 

Immediately and gently remove air bubbles attached to the sample using forceps (especially 

around the anthers) (Figure 3B). Bubbles may affect the quality of sectioning (Figures 3C 

and 3D). 

3. Trimming of agarose block 

a. After complete gelling of agarose, pull out agarose blocks and trim them manually using a 

razor blade (Figures 3E and 3F). Shaping the block into a truncated pyramid enforces its 

stability on the vibratome stage, and leads to better sectioning. Pay attention to positioning 

the sample aside of the top square of the truncated pyramid (Figure 3G) (see the next step 

for this reason). 
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Figure 3. Agarose embedding and trimming. A. Pouring melted agarose into CRYO DISH 

with a dissected flower sample. B. Removing bubbles around the sample using fine forceps. C. 

A stereo microscopic view when embedding is successful. No bubble was found around the 

sample. D. A stereo microscopic view when embedding is inappropriate. A large bubble attaches 

to the embedded anther (an arrow). E. An agarose block removed from a CRYO DISH after 

complete gelling. F. Trimming of agarose block as locating the anther at the top of the block for 

ease of subsequent sectioning (an arrow). G. Schematic illustrations of the trimmed gel block 

and the position of plant samples within it. 

 

b. Fix the trimmed block onto the vibratome stage with Krazy Glue adhesive agent. Pay 

attention to its direction on the stage, as the embedded sample comes to the front side, but 

not to the far (Figure 4A). The razor blade slices the block from far to front sides (Figure 4B), 

and thus, positioning at the front side is beneficial to prevent the sample from a direct tension 

by the blade, leading to better structural maintenance of sample organs. 

c. After the adhesive agent completely dried up, set the stage onto the vibratome, adjust the 

razor blade in an appropriate angle as manufacturer's instruction, and fill the stage with 

ddH2O. 
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d. Further, trim the agarose block by vibrating (100 μm or 200 μm thickness) until the blade 

reaches to the embedded sample. DO NOT miss a moment when the sample firstly appears 

in floating gel slices, in which you can see the sample as a tiny dot. 

4. Sectioning and mounting 

a. Change the vibratome setting to your desired thickness (usually, 50 μm thickness or less), 

and start sectioning. 

b. To collect a floating gel slice, dip one end of the slide glass into water filling the vibratome 

stage, and carefully scoop up the slice onto the glass with forceps (Figure 4D). 

 

 
Figure 4. Sectioning using vibrating microtome. A. A fixed agarose block set onto the 

removable stage of vibratome. B. The sample block set onto vibratome. An orange arrow 

indicates the direction of slicing. C-D. Placing the picked-up gel slice to the water surface on a 

slide glass (a dashed box). 

 

c. Remove the excess water surrounding the gel slice by clean wiping papers (Figure 5A). 

d. Drop 15 μl of DAPI-containing VECTASHIELD onto the slice before the sample dried up. 

Then gently mix the VECTASHIELD droplet on the slice by pipetting several times. DO NOT 

touch the gel slice during pipetting. 

e. Cover the section with a coverslip and seal with the nail polish (Figure 5B). Incubate for 10 

min-1 h at room temperature, or at 4 °C until CLSM observation. 
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Figure 5. Mounting and sealing. A. A stereo microscopic view of the sample section on the 

slide. Anther sections (an arrow) were successfully positioned at a rim of the agarose slice (the 

rim was traced with a dashed line). B. A ready-to-observe sample mounted on a glass slide with 

DAPI-containing VECTASHIELD, covered with a coverslip and sealed with nail polish. 

 

5. Observation and image processing 

a. Set the slide glass on CLSM and drop 50 μl of oil or ddH2O between the slide and the 

objective lens (e.g., Olympus UPlanApo 60x/1.20W [water-immersion lens]). 

b. Set up the wavelength of laser excitation at 351 nm for DAPI and 488 nm for GFP. For 

detection, use the bandpass emission filters ranging from 430 to 460 nm for DAPI and 505 

to 525 nm for GFP. 

c. Capture the images of DAPI and GFP separably via the operating system of your own CLSM. 

d. Pseud-color DAPI and GFP images in different colors. In Figure 6, DAPI is peudo-colored 

in magenta and GFP in green. 

e. Use ImageJ or Photoshop CC (Adobe) software when two images should be merged (see 

Notes for specific manipulation methods of ImageJ or Fiji). 

 

 
Figure 6. Captured images from an anther section. Captured fluorescent images of DAPI 

(magenta) and GFP (green) and a merged image processed by ImageJ. Here, anthers from the 

transgenic rice plant expressing MEL1pro-GFP-MEL1 (Ono et al., 2018) were used. Scale bars 

= 20 μm. 
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Notes 
 

1. Whenever you fix samples, freshly prepare 4% PFA/PMEG fixative just before use. 

2. Fixed samples can be stored at 4 °C for up to several months, while the duration depends on 

the expression level of fluorescent-tagged proteins. Actually, we could detect GFP fluorescence 

in the fixed samples after 8 months storage. 

3. Be careful if you examine heat shock-responsible genes, because agarose embedding 

procedures may affect the expression levels in live samples. 

4. GFP signal is detectable for a half day or more after agarose embedding, even in live samples, 

while the activity will be changed due to the properties of proteins and plant tissues, temperature 

and other conditions. 

5. The manipulation methods of ImageJ or Fiji for pseudo-coloring and merging are as follows: 

a. Open DAPI and GFP images (TIFF files). 

b. Adjust the contrast to an appropriate level by the menu, Image → Adjust → Window/Level. 

c. Merge two (or more) images by Image → Color → Merge_Channels. 

d. In the box displayed, set the DAPI image to C6 column (magenta) and the GFP image to 

C2 column (green), and check the boxes of “Create composite”, “Keep source images” and 

“Ignore source LUTs”, and go to “OK”. Here, other channels and colors can be selected as 

you like. 

e. Activate the composite file created, and stack the components of the file into a single RGB 

image by Image → Color → Stack_to_RGB. 

f. Save the image by File → Save_As. 

 

Recipes 
 

1. 5x PMEG stock buffer (1 L) 

125 mM PIPES 

25 mM EGTA 

12.5 mM MgSO4 

20% Glycerol 

1% Dimethyl sulfoxide (DMSO) 

Adjust to pH 6.8 

 

How to make 1 L of 5x PMEG stock buffer: 

PIPES (Wako Pure Chemicals) 75.6 g (final concentration 125 mM) 

EGTA (Wako Pure Chemicals) 19.23 g (final concentration 25 mM) 

MgSO4·7H2O (Wako Pure Chemicals)  6.15 g (final concentration 1.25 mM) 

a. Dissolve above chemicals in 600 ml of DW 

b. Add KOH solid (60 g or more, Wako Pure Chemicals), and adjust the pH to 6.8. Once the 
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pH reaches 6.8, the solution will become clear 

c. Dilute the solution to 800 ml, add 200 ml of glycerol (Wako Pure Chemicals) and mix well 

d. Transfer the solution into an autoclavable bottle and do autoclaving, and store at 4 °C before 

use 

e. Just before the first use, add 10 ml of DMSO (Wako Pure Chemicals) and mix well 
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